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Explanation of icons:

 



Approximate time needed to complete this lecture

 



Do the given exercise and write down the answers






Look out for the following possible programming errors

· Outcomes for this lecture




Do on the computer






Use the programs on the stiffy





Read in the said publication or prescribed book





Helpful hint

Lecture 1
Editing and executing programs

Writing to the screen

Learning objectives

	After you have studied this section, you

· will know your way around the Turbo Pascal environment, that is opening, typing, editing, saving and closing files
· will know how to write and execute a simple program in Turbo Pascal
· will know a few basic Turbo Pascal commands


For this lesson you will need:

	


Access to a computer with Turbo Pascal loaded on it

· An hour or more to work through this lesson
· A pen to write down all the answers


1.11 Getting around in the Turbo Pascal Environment
In CAPF11 you learnt how to run programs from different operating systems.  Using that knowledge, load Turbo Pascal onto your computer.  When you’ve done that, the screen will look like this:
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This is the Turbo Pascal Editor (or edit window) in which you will write all your programs.  To create a new Turbo Pascal program, you must begin with an empty Edit Window on the screen.  When you load up Turbo Pascal, you will automatically be in an empty edit window.  To open a new window yourself, select the New option from the File menu.  You can select an option by either clicking on the item with the mouse, or by pressing the alt key, and then using the arrows to move to the correct choice.  Pressing enter will tell the computer to execute your choice. 
[image: image2.png]



To get around in Turbo Pascal’s editor, you can just start typing, using the keyboard.


Type the following program in the edit window:

	
	Program FirstTry;

begin

Writeln(`Hallo World!`);

Writeln(`Programming in Turbo Pascal is easy.`);

Writeln(`Computers are fun!`);

Readln;

end.


Computers are not intelligent.  They can only follow instructions.  A program is a list of instructions telling the computer what you want it to do.  If you were the computer, what would you do with these commands?

At this stage, your program is only in the computer’s temporary memory, which means that the program will be lost if you switch the PC off or a power failure occurs.  If you want to refer to the program at a later stage, you need to save it on the computer’s hard drive or on a stiffy.  To save the program, choose the Save option from the File menu, and then type the name of the file, ‘Prog1'.  Turbo Pascal will automatically add the extension .pas to the file to indicate that it is a Pascal file. To save the file on a stiffy, type ‘a:\prog1’.
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Now you want to execute the program.  Before you can do that, the code has to be translated from Turbo Pascal (the language you’ve written the program in) to machine language, a language that the computer understands.  To do this, choose the compile option from the compile menu.  
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After compilation, your screen should look like this:
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If you don’t see the message ‘Compile successful: Press any key’, there might be typing errors in your program.


Correct any mistakes and try to compile the program again.  When the compilation has been successful, the program is ready to be executed.  Choose the Run option from the Run menu, and watch the program execute.

What do you see on the screen?

	
	


Insert ClrScr; before the first Writeln statement.  Your program should now look like this:

	
	Program FirstTry;

begin

ClrScr;
Writeln('Hallo World!');

Writeln('Programming in Turbo Pascal is easy.');

Writeln('Computers are fun!');

Readln;

end.


Try to execute the program.  Write down the error message that is displayed on the screen.

	
	


Insert Uses Crt; before the begin statement.  Your program should now look like this:

	
	Program FirstTry;

Uses Crt;
begin

ClrScr;

Writeln('Hallo World!');

Writeln('Programming in Turbo Pascal is easy.');

Writeln('Computers are fun!');

Readln;

end.



You have made a few changes on the program that you originally saved as Prog1.pas.  If you choose the save option from the file menu, Turbo Pascal is going to replace the original copy with the new version.  If you want to save the new version, but don’t want to loose the original program, you can save it under a different name.  Save this program now as Prog2.pas.  To save the file under a different name, click on the  save as option in the file menu.  Execute the program.  Write down the difference between this program and the original one (Prog1.pas).

	
	


Change the program as follows:

	
	Program FirstTry;

Uses Crt;

begin

ClrScr;

Writeln('Hallo World!');

ClrScr;
Writeln('Programming in Turbo Pascal is easy.');

ClrScr;
Writeln('Computers are fun!');

Readln; {Delete this statement later}

end.


Save the program as Prog3.pas and execute it.

Write down what appears on the screen.

	
	


What does ClrScr do?

	
	


Does the comment in brackets  {Delete this statement later} have any effect on the program?

	
	


Delete the Readln statement.  Execute the program and write down what happens.
	
	


Insert the Readln where it was, and insert Readln after the Writeln statements as indicated below.  Your code should look like this:
	
	Program TryAgain;

uses Crt;

begin

ClrScr;

Writeln('Hallo World!');

Readln;
ClrScr;

Writeln('Programming in Turbo Pascal is easy.');

Readln;
ClrScr;

Writeln('Computers are fun!');

Readln;
end.


Save it as Prog4.pas.  Execute the program.  What is the effect of  readln; in your opinion?

	
	


Delete the semicolon after the first ClrScr.  Try to execute the program.  Write down the error message that appears on the screen.

	
	


Turbo Pascal is a programming language.  Just like other written languages, programming languages use punctuation marks to clarify the meaning.  In Turbo Pascal, semicolons indicate the end of a statement or command.  The full stop after end indicates that the end of the program is reached.  Turbo Pacal will ignore any statements after the ful stop.

Load Prog2.   To do that, choose the Open option from the File menu.  Then choose Prog2.pas from the list of files.  You can choose the file by clicking on the filename with the mouse, or you can move around with the arrow keys and press enter when you’ve found the correct one.  To move the cursor to the filenames without a mouse, press the tab key.
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If the filename does not appear on the alphabetical list, it was either not properly saved or it was saved in a different directory or too far down in the alphabet to be displayed.  View the files possibly not displayed by moving to the name of the last file (with the mouse or the arrow keys) and then use the arrows to unveil more file names.  If the file is not there, you can click on the ..\ - in the list of filenames, to search the other directories for the file.

To change the default directory, choose the Change Directory option from the File menu and choose (or type) the appropriate directory name, e.g. A:\
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Now that you’ve loaded the program, change every Writeln in the program to Write.  Your program should look like this:
	
	Program TryOnceMore;

uses Crt;

begin

ClrScr;

Write('Hallo World!');

Write('Programming in Turbo Pascal is easy.');

Write('Computers are fun!');

Readln;

end.


Save the program as Prog5.pas and execute the program.  Write down what you see on the screen.
	
	


Load Prog2.pas.  Insert the bold-typed lines in the program and save it as Prog6.pas.
	
	Program FirstTry;

Uses Crt;

begin

ClrScr;

Writeln('Hallo World!');

TextColor(Yellow+Blink);

Writeln('Programming in Turbo Pascal is easy.');

TextColor(Yellow);
Writeln('Computers are fun!');

Readln;

end.


Execute the program.  What is the effect of TextColor(Yellow + Blink); ?

	
	



Now change TextColor to tExtcOLOr; texTCOLOR; and TEXTCOLOR.  Do the capital letters change the effect of the command? 
	
	


Because the commands in Turbo Pascal are not case sensitive, we can use capitals to make the programs more readable.  TextColor is preferred above tExtcOLOr, because it is easier to read.

Load Prog2.pas, add the bold-typed statements to the program and save it as Prog7.pas.
	
	Program FirstTry;

Uses Crt;

begin

ClrScr;

Writeln('Hallo World!');

Writeln ( Chr(137) );

Writeln('Programming in Turbo Pascal is easy.');

Writeln('Computers are fun!');

Write ( Chr(2) );
Readln;

end.


What character is represented by chr(137)?

	
	


Load Prog2.pas again and execute it.  Then change it as follows:

	
	Program FirstTry;

Uses Crt;

begin

ClrScr;

Writeln('Hallo World!' :50);

Writeln('Programming in Pascal is easy' :50);

Writeln('Computers are fun!' :50);

Readln;

end.


Save it as Prog8.pas and execute it again.  Replace the number 50 with other numbers and notice the effect.  What is the difference between the output of this program and the original Prog2.pas?

	
	


Insert Writeln; after Writeln('Hallo World!' : 50);.  Your code should now look like this:

	
	Program FirstTry;

Uses Crt;

begin

ClrScr;

Writeln('Hallo World!' :50);

Writeln;
Writeln('Programming in Pascal is easy.' :50);

Writeln('Computers are fun!':50);

Readln;

end.


What is the effect of Writeln;?

	
	




Change the program completely to look like this:

	
	Program FirstTry;

Uses Crt;

begin

ClrScr;

Sound(440);

Delay(1000);

NoSound;

Sound(880);

Delay(2000);

NoSound;

Readln;

end.


Save the program as Prog7.pas.

Experiment with different values for Sound.  What is the effect of bigger values for Sound?

	
	



Experiment with different values for Delay.  What is the effect of bigger values for Delay?

	
	


Now move the commands around as indicated:

	
	Program FirstTry;

Uses Crt; begin

ClrScr; Sound(440);

Delay(1000);

NoSound;

Sound(880);

Delay(2000);NoSound;

Readln;end.


Execute the program.  The output of this program, and the original Prog7.pas are identical.  BUT the original program is much neater and much more understandable.  Always use indentation, open lines and spaces to make your program appear as neat and readable as possible.

To exit Turbo Pascal, choose Exit from the File menu.
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1.2
What you’ve learnt in this chapter
The general structure of a Turbo Pascal program:

	Program FirstTry;

Uses Crt;

begin 
{Program statements}

{Program Statements}

end.



	Uses Crt;
	Includes functions and procedures from the CRT-library for use in your programs.

	ClrScr;
	Clears the Turbo Pascal Output window and returns the cursor to the top left-hand corner of the screen.

	Writeln;
	Writes an end-of-line-marker to the screen.  The effect will be a blank line.

	Writeln(`stuff`);
	Outputs the word stuff to the screen and moves the cursor to the next line.

	Write(`stuff`); 
	 Outputs the word stuff to the screen and leaves the cursor on the same line.

	Write(`Pete``s stuff`);
	Outputs Pete`s stuff to the screen.  To write an inverted comma to the screen, two inverted commas are used.

	Readln;
	Waits for the user to press enter before the next statement in the program is executed.  If the readln at the end of a Turbo Pascal program is omitted, the program will execute and jump back to the editing screen.  To view the output window, or toggle between the output window and the editing screen, press <alt> <F5> simultaneously.

	TextColor(2);
	Changes the colour of the text to the value assigned to the number.  Colour 0 will always be the same as the current background colour.  There are normally 16 colours available:  values range from 0 to 15.  You can make characters blink by adding 128 to the value of the colour.  If you type textcolor in the Turbo Pascal editor, and then choose topic search from the help menu, Turbo Pascal will tell you more about this procedure and related procedures and give you sample code which you can copy into the editor and execute.

	Write(Chr(137));
	Writes the character which corresponds with 136 to the screen. All characters on the keyboard, and some characters not found on the keyboard, are assigned a number value.  These numbers and values can be seen in appendix A - the ASCII table.  Writeln(Chr(137)) will ouput   ë, the same character that will be printed when the alt key is held down while the numbers 1, 3 and 7 are pressed on the number keypad on the right side of the keyboard.

	Write(`stuff`:30);
	Writes stuff to the screen, fitted (with the characters of stuff included) into 30 spaces.  The effect will be 25 blanks followed by the word stuff.

	{ stuff  }
	Comment statements, usually added to increase readability or explain reasoning in a program.  Also used to ‘comment out’ parts of a program when debugging.  Everything inside the brackets will be ignored by the Turbo Pascal compiler.

	(* stuff *)
	Will do the same as {stuff}.  Necessary if for example a piece of code is ‘commented out’, but that piece of code contains comments.

	Sound(440);
	Activates the PC’s internal speaker and produces a sound of 440 Hz.  (440 Hz is the frequency of the A beyond middle C on a piano.)  The higher the frequency, the higher the tone of the sound will be.  If you forget to include the NoSound-command, the PC’s speaker will keep making that sound until the machine is rebooted or Turbo Pascal aborted !

	NoSound;

	De-activate the PC’s internal speaker.  It is important to remember when playing with the Sound procedure!

	Delay(100);
	Specify the number of milliseconds the computer has to wait before executing the next statement.  The number is an approximation and the actual time the PC will wait, will depend on the speed of the processor. 


Lecture 2
Variables


Learning objectives

	After you have studied this section, you

· will know how to declare variables in Turbo Pascal
· will know how to assign values to variables
· will know how to display the values of variables
· will know how to read a program and predict the output of a Turbo Pascal program using variables correctly



For this lesson you will need:

	


Access to a computer with Turbo Pascal loaded on it

· One hour to work through this lesson
· A pen to write down all the answers



Publication for CSCA11, chapter 2


2.1
Variables

Read through paragraphs 2.3, 2.4 and 2.5 in the publication for CSCA11.

The concept of variables is introduced in paragraph 2.3 of the study guide for CSCA11.  It is important to always use sensible (meaningful) names for variables.  FirstName and NumberOf means much more than a or x, although Turbo Pascal allows both.  There is no restriction on the length of a variable name, but bear in mind that you are going to use it often and don’t want to type TheVariableUsedForKeepingTrackOfTheMarksForTheExam too often if Marks is sufficient.


Use a combination of capital and small letters for the identifiers chosen by yourself to make the names more readable.  WhatALotIGot is much more understandable than whatalotigot or WHATALOTIGOT.

Let’s code the statements given in 2.4 (in the publication for CSCA11) into Turbo Pascal:

	
	Program TestVariables;

Uses Crt;

begin

ClrScr;

Readln(Radius);

Writeln(Radius);

Readln;

end.


Now try to execute the program.  Write down the error message:

	
	


Turbo Pascal won’t allow you to use undeclared variables.  The declaration will tell Turbo Pascal the type of the variable.  Different kinds of variables are treated differently.  Add the variable declaration to the program:

	
	Program TestVariables;

Uses Crt;

Var

Radius : Integer;
begin

ClrScr;

Readln(Radius);

Writeln(‘ Radius is ‘, Radius);

Readln;

end.


Execute the program.  It looks as if nothing is happening.  You can hit the Enter key as many times as you like, nothing will happen.  If you enter a number, Turbo Pascal will be satisfied and write the number you’ve entered to the screen.  The problem with this program is - how are you supposed to KNOW the computer wants you to enter a number?  Now if the computer ASKED you to type the radius ... change the program as follows:

	
	Program TestVariables;

Uses Crt;

Var

Radius : Integer;

begin

ClrScr;

Write(‘Enter a value for the radius > ‘);
Readln(Radius);

Writeln(‘ Radius is ‘, Radius);

Readln;

end.


Save this program as TestVar and then execute it.  What value did you enter?  Did Turbo Pascal remember it correctly?

At this stage it should be clear that Turbo Pascal will execute all the statements between begin and end in the order they are written.  In the program above, the statement ClrScr; will clear the screen.  Then the write-statement will write to the screen whatever appears between the inverted commas.  After that, Readln(Radius) will assign the value typed on the keyboard, to the variable radius.  Then the writeln statement will display something (everything between the brackets, that is) on the screen and finally the readln statement will wait for the user to press enter before the end is reached and the program jumps back to the Turbo Pascal editor.

Now change the program as indicated:

	
	Program TestVariables;

Uses Crt;

Var

Radius : Integer;

begin

ClrScr;

Write(‘Enter a value for the radius > ‘);

Readln;
Writeln(‘ Radius is ‘, Radius);

Readln;

end.


Execute the program.  What value did you enter for Radius?  Did Turbo Pascal remember it correctly?
	
	Make sure the computer reads the value of the variable entered by the user.  Readln; and Readln(Radius); are NOT the same thing.

Readln; merely waits for the user to press enter; if anything else is typed before enter, Turbo Pascal will just ignore that.
Readln(Radius); stores the value (typed by the user) in the memory cell with the name  Radius.


Load program TestVar.  Execute the program again, this time entering a fraction when asked for the radius.  Fractions are entered in decimal form; that is 2½ is entered as 2.5 (and not 2,5).  Write the error message in the box:

	
	


Radius was declared as an integer.  Turbo Pascal won’t allow you to read real values into a variable that was reserved for integers only.  To solve this problem, you can declare the variable as a real number:

Var
Radius : Real;
Change that in your program and execute it.  What value did you enter for Radius?  Did Turbo Pascal remember it correctly?  Could you understand the output?  If the computer  isn’t told HOW to represent real numbers, Turbo Pascal will display them as they are stored in the memory cells - in a format resembling scientific notation.  To change the format, you can try the following: 

	
	Program TestVariables;

Uses Crt;

Var

Radius : Real;

begin

{other statements...}

Readln(Radius);

Writeln(‘ Radius is ‘, Radius :7 :3);

Readln;

end.


The last number  (:3)  indicates how many decimals must be displayed.  The 7 indicates how many total spaces must be reserved for the variable value.  If a blank is represented by ^, possible output for different values of Radius may be:

^ ^ 0 . 5 0 0

1 2 3 . 4 5 7

^ ^ 3 . 0 0 0

1 2 3 4 . 5 6 8
If the value has more than 3 decimals, the number displayed will be rounded off.  The decimal point also occupies a position.  Note that the last example uses 8 positions.  The last number (:3)has precedence over the total number of positions allocated to the variable.  If more than 7 spaces are needed, Turbo Pascal overrides the :7, and uses as many positions as needed.

2.2
Assigning values to variables

Read through paragraphs 2.6, 2.7 and 2.8 in the publication for CSCA11.

It is important to make sure that variables are assigned values BEFORE they are used in a program.  Methods and reasons are explained in paragraph 2.8.  The algorithm in paragraph 2.7 can be coded into Turbo Pascal as follows:

	
	Program CodeTheAlgorithm;

Uses Crt;

Var

Radius, Area, Pi : Real;

begin

Write(‘This program calculates the area ’);

Writeln(‘of a circle’);

Write(‘Enter the radius of a circle ‘);

Readln(Radius);

Pi := 3.14159;

Area := Pi * Radius * Radius;

Write(‘ A circle with radius ‘, Radius:5:2,);

Writeln(‘has an area of ‘, Area:5:2);

Readln;

end.


2.3
Other types of variables
Sometimes you want to use a value that is not a number in a Turbo Pascal program.  You may want to use a student’s name, or the symbol she obtained for a maths test.  Turbo Pascal allows you to declare variables for this purpose as a string or a character: A string variable can store any name or any other characters that you can enter from the keyboard, to a maximum of 255 characters.  A variable of type char can store any single character.  Type and execute the program on the next page:

	
	Program TestStuff;

Uses

Crt;

Var

Name : String;

Symbol: Char;

begin

ClrScr;

Write(‘Your name please? ‘);

Readln(Name);

Write(‘Symbol? ‘);

Readln(Symbol);

Writeln(‘Good morning, ‘, Name, ‘!’);

Writeln(‘Hey ‘, symbol, ‘ is not bad at all!‘);

Writeln(‘Changing the value of name now ...’);

Name := ‘Peter’;

Writeln(‘Changed name : ‘, Name);

Readln;

end.


If 8 was entered when the program asked a value for symbol, Turbo Pascal would handle that 8 as the character 8 and not the number 8.  Calculations with 8 would therefore be impossible.  More about strings, characters and other data types in lecture 5.

2.4
Constants
Sometimes you want to use a ‘variable’ with a fixed value in a program.  You can declare constants instead of typing the value in the program code every time.  The constant declaration is usually done before the variable declaration, as in the following example:

	
	Program DemoConstant;

Uses

Crt;

Const

Vat = 1.14;

Var

Num: Real;

begin

ClrScr;

Writeln(‘Enter the number ‘);

Readln(Num);

Num := Num * VAT;

Writeln(‘Number after tax: ‘, Num:6:2);

Readln;

end.


The value of a constant cannot be changed inside the program.

2.5
What you’ve learnt in this chapter
The general structure of a Turbo Pascal program making use of variables:

	Program FirstTry;

Uses

Crt;

Const

Value = 20;

Var

Num, AnotherNum : Integer;

YetAnotherNumber : Real;

begin 
{Program statements}

{Program Statements}

end.


	Readln;
	Waits for the user to press enter before the next instruction is executed.

	Readln(Number);
	Assigns the value typed in on the keyboard, to the variable Number.


2.6
Self-test Questions
2.6.1
Show the output lines for the following statements (use ^ to indicate spaces):

Write(-99 : 4);

Writeln(‘Bottles’ : 8);

Writeln(‘-99' : 4);

Writeln(-99 : 8 : 2);
2.6.2
Correct the following statements:

Write ln("Science is organized knowledge.");
Write("Wisdom is organized life.");
2.6.3
Show how the value -15.564 (stored in X) would be printed using these formats: (use ^ to indicate spaces):

X :8 :4

X :8 :3

X :8 :2

X :8 :1

X :8 :0

X :8
2.6.4
Assuming X (type Real) is 12.335 and i (type Integer) is 100, show the output lines for the following statements.  For clarity, use the symbol ^ to indicate a blank space.

Writeln(‘X is ‘, :10, X:6:2, ‘i is ‘, :4, i:5);

Write(‘i is ‘ :10, i:1);

Writeln(‘X is ‘ :10, X :2 :1);
2.6.5
What value is assigned to X by the following statement?

X := 25.0 * 3.0 / 2.5;
2.6.6

What value is assigned to X by the following statement, assuming X is 10.0?

X := X - 20.0;
2.6.7

What is illegal about the following declarations and statement?

Const

MyPi = 3.14159;

Var

C, R : Real;

Begin

MyPi := C / (2 * R * R);

End.
2.6.8
Write a computer program that reads in the length and width of a rectangle, and then calculates and displays the area of the rectangle.


Lecture 3
Selection Structures


Learning objectives

	After you have studied this section, you

· will know what a selection structure is
· will know how to use the if and case statements in Turbo Pascal
· will know how to solve problems involving the if and case structures
· will be able to predict the output of a Turbo Pascal program using the if and case statements.


For this lesson you will need:

	


Access to a computer with Turbo Pascal loaded on it





The stiffy supplied with Pascal := Work + Fun, module two

· Two hours or more to work through this lesson
· A pen to write down all the answers in  Pascal := Work + Fun



Publication for CSCA11, chapter 10

Pascal := Work + Fun, module two, pages 1 - 36


3.1
The If statement

Read through chapter 10 of the study guide for CSCA11.

Pascal := Work + Fun is a workbook.  As in lectures 1 and 2 of this study guide, you will continuously be required to test programs on a computer or write down results.

Now work through pages 1 to 26 of Pascal := Work + Fun, module two.  Try to predict the answers of the program given in number 1 of exercise 1 on page 3 before executing and testing the program.  Note the indentation of the program given in exercise 2, number 3 on page 7.

Work carefully through all the exercises and KwikWiz questions on pages 3 to 27.  It will take some time, but it will be well worth the effort.

3.2
The Case statement
Sometimes the conditions in an if-statement are just too many, so that the program gets a bit messy.  On page 28 in module two of  Pascal := Work + Fun is an example of what such a program will look like.  (Take note of how the character variable choice is dealt with in the program.)  Pages 28 to 36 deal with the solution.  Try to answer all the questions in the KwikWiz and exercises 10 and 11 on pages 32 to 36.

	The arrow keys or the mouse can be used to move around in the editor.  The delete key will delete the character directly above the cursor; the backspace key will delete the character preceding the cursor.  The Enter key will move the cursor to a new line (insert a blank line). 


	





	Make sure that all the commands are spelt correctly, that the semicolons are inserted as shown, and that the single inverted comma is the character found next to the semicolon (the same one is used for both opening and closing the quotation), and not the one to the left of ‘1' on the keyboard.


	





	Crt is a unit that contains a library of extra screen-related non-standard Pascal procedures like ClrScr.


	





	To change the default directory (the one where Turbo Pacal will automatically start to search for files), choose the Change Directory option from the File menu and choose (or type) the appropriate directory name, e.g. A:\


	





	In the appendix of Pascal := Work + Fun, module three (page iii), you’ll find a table of numbers and their corresponding colours.


	





	It is very ineffective to delete a lot of program code using the delete key.  The following two methods for deleting text may be used:


	Move the cursor to the line to be deleted and press <ctrl> <Y> simultaneously.


	Mark all the text to be deleted using the mouse, and then choose Cut from the Edit menu.


	





	To mark text using a mouse:


	Move the cursor to the first character to be deleted.


	Hold the left mouse button while moving the mouse down to the last character to be deleted.  All the characters included in the grey block is ‘marked’ or ‘blocked’.





	In the appendix of Pascal := Work + Fun, module three (on page iii) you will find a table with frequencies for some keys.





	Actually, there IS a restriction on the length of a variable name: Turbo Pascal won’t allow variable names containing more than 127 characters.


		All Turbo Pascal variable names (and names of procedures and programs) must start with an alphabet character.


		After the first character you may use underscore ( _ ) or any numerical or any alphabet character.  Special characters like * or spaces are not allowed.


		Pascal reserved words (like FOR) may not be used for variable names.
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